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Resource Library

Using the Resource Library

On this tab you find an assortment of resources to help you learn more about Cisco Unified
Communications.

« Cisco Unified Communications System Description

» Cisco Unified Communications System Release Notes
» Network Topology Resources

» Ordering Guides for Cisco Partners and Employees

» Troubleshooting Individual Components

- Component Resources

» Configuration Command Files

» System Test Results

« Cisco Sales Demo

Cisco Unified Communications System Description

For Release 5.0(2):
Cisco Unified Communications System Description (right-click to download PDF)

Cisco Unified Communications System Release Notes

System Release Notes for |P Telephony: Cisco Unified Communications System, Release 5.0(2)

Network Topology Resources

This topic provides topology resources that you can use to document network plans. Specifically, it
includes:

- Microsoft Visio Network Topology Diagrams as individual Microsoft Visio files

» How to Use Microsoft Visio Drawings Efficiently, guidelines for best practices in using Microsoft
Visio files
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Microsoft Visio Network Topology Diagrams

You can download zip files containing Visio drawings of the logical and physical topologies for IP
telephony. Table 7-1 identifies the Visio drawings in each zip file.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio

Stencils resource page.

Table 7-1 Microsoft Visio Topology Diagrams

Description

Filename

Zip fileincludes the site model topology drawings
listed bel ow.

IPT_STARM_SiteModels.zip (right-click to
download zip) 4.5 MB

Note If youclick thelink rather than right-click,
the zip file may open in the secondary
window but also replace the contents of
this window. Use your Back button to
return to this window.

All test sitesin North America Multisite
Distributed deployment

SiteModel_NorthAmerica_All.vsd

All test sitesin Europe and Emerging Markets
(EUEM) Multisite Distributed deployment

SiteModel EUEM_All.vsd

Very Large Campus Clustering over the WAN
(SJC-RFD) site model

SiteModel_LargeCampus_SJCRFD.vsd

Multi-Site Centralized, Clustering over the
WAN with Unified SRST (SFO-ORD) site
model

SiteModel_MultiCentralized SFOORD.vsd

Large SIP Site (DFW) site model

SiteModel_LargeSIP_DFW.vsd

Small-Campus H.323 Site (Y'Y Z) site model

SiteModel_SmallH323_YYZ.vsd

Small-Campus SIP Site (ATL) site model

SiteModel_SmallSIP_ATL.vsd

Non-Cisco CallManager Interoperability Site
(HNL) site model

SiteModel_NonCallManagerinterop_ HNL.vs
d

Cisco CallManager Interoperability Site
(NYC) site model

SiteModel_CallManagerinterop_NY C.vsd

Small Site (RDU) site model

SiteModel_SmallSite RDU.vsd

Zip file includes component topology drawings
listed below.

IPT_STARM_Components.zip (right-click to
download zip) 5.4 MB

Note If youclick thelink rather thanright-click,
the zip file may open in the secondary
window but also replace the contents of
this window. Use your Back button to
return to this window.

Cisco Unified CallManager Express and
Cisco Unity Express test topology

CME_CUE_Site Topology.vsd

Cisco | P Video Telephony topol ogy

IPVideo_Overall Topology.vsd

Multisite Centralized video deployment using
Cisco IP Video Telephony PSTN gateway

IPVideo_MultiCentralized EUEM.vsd
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Microsoft Visio Topology Diagrams (continued)

Description

Filename

Basic video deployment with Cisco RSVP
Agent

IPVideo_WithRSVP.vsd

Cisco Unified MeetingPlace Topology in
Multisite Distributed Deployment

M eetingPlace_Topology.vsd

QSIG connections to a Cisco Unified
CallManager cluster

QSIG_Topology.vsd

Cisco Unity logical topology

Unity_Logical_Topology.vsd

Cisco Unity and Unity Connection physical
topology - North America

Unity_NA_Site_Topology.vsd

Cisco Unity setup in EUEM test environment

Unity EUEM_Site Topology.vsd

Cisco Unified CallManager Express
integrated with Cisco |P-to-IP Gateways

CME_IP-1P_Gateways.vsd

Security test topology using Cisco Catalyst
Firewall Security Module (FWSM)

SecurityTopology FWSM.vsd

Security test topology using Cisco Secure PIX
Firewalls

SecurityTopology_PIX.vsd

Cisco Unity Connection test topology for

UnityConnection_MultIntegration.vsd

Unified CallManager and Unified
CallManager Express multisite integration

How to Use Microsoft Visio Drawings Efficiently

Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word,
Powerpoint). Unfortunately, the default method isto insert the whole “ Visio object” into afile. This can
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the
application data with the drawing. This object information is needed if you want to be able to
double-click the drawing from Word or Powerpoint and have it open up in Visio for editing. But pasting
as an object adds many megabytes to the size of your file. With only a few such drawings, a Word
document can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers,
and atrial for partners or customers to download. (They might even give up beforeit isdone.) In
addition, very large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Step 1
Step 2

Unless you really need the live editing capability, avoid unnecessary file bloat by performing an extra
step when you paste:

In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special
dialog box, choose Picture (Windows M etafile).

Cisco Unified Communications System for IP Telephony Release 5.022)
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Step 3

Paste Special 1 E|
Source:  Wisio 2000 Drawang
C:\Documents and Settingsihweisert\My D... o ]
=
(%) Paste: j
() Paste fink:
Result

Inserts the contents of the Clipboard as & windows

@ metafile picture,

Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose For mat >
Picture, click the Layout tab and select I n line with text. Thisis generally the most reliable layout
option.

The Bottom Line
Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special.

Downsizing Existing Drawings

Step 1

Step 2

Tip

If adocument islarger than it should be, you can check to see if the Visio drawings are the reason and,
if so, fix the problem.

With the drawing selected in the Word or Powerpoint document, choose Edit. At the bottom of the Edit
menu, you will see one of the following:
- Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much
more file space than it needs to. Go on to step 2.
- Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file
size.
If the drawing is an object, cut it (Ctrl-X), then repaste it asin Bringing a Visio Drawing into a
Document.

You can easily click through the document to check each picture by using Word's handy Go To feature:
Where you want to start searching, press Ctrl-G. In the Go to what list, select Graphic and click Next.
You go to the next graphic. Click it to select, and then check asin step 1. If needed, repaste asin step 2.
Click Next and continue these steps for other graphics.

l_ Cisco Unified Communications System for IP Telephony Release 5.0(2)
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Ordering Guides for Cisco Partners and Employees

Ordering Guides for Cisco Partners and Employees

~

Note

Ordering guides for most Cisco Unified Communications products are available for Cisco partners and
employees.

Some of these guides require software to open, such as Microsoft Powerpoint or Adobe Acrobat Reader.
You can also right-click on these files and select Save Target As to download them to your desktop.

Software Bundles
» Unified Communications Solution Bundle (Powerpoint)

Call Control, End Points, and Call Control Applications
» Cisco Unified CallManager 5.0 (Powerpoint)

» Cisco Unified IP Phones (Powerpoint)

- Cisco Emergency Responder (this will be available in a future release)

- Cisco Unified MobilityManager (this will be available in a future release)
« Cisco CallManager Express &

« Cisco Unified Survivable Remote Site Telephony (SRST) &

Contact Center

» Cisco Customer Contact Center Business Unit Price List (PDF)—This list addresses pricing and
packaging structure for all Contact Center products.

Conferencing
» Cisco Unified MeetingPlace (PDF)

» Cisco Unified MeetingPlace Express (PDF)

Messaging
» Cisco Unity (PDF)
- Cisco Unity Connection (PDF)

Network Management
« Operations Manager (this will be available in afuture release)

« Service Monitor (thiswill be available in a future release)

Troubleshooting Individual Components

Seethetable | P Telephony Component Troubleshooting Tools and Documentation on the Implement tab
for individual component troubleshooting information.
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http://www.cisco.com/web/partners/downloads/partner/WWChannels/technology/ipc/downloads/mpe_priceguide.pdf
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The following list contains links to individual component documentation for the Cisco Unified
Communications family of products.

Voice Documentation
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products support_category _home.html

Cisco Unified CallManager
http://www.cisco.com/en/US/products/sw/voicesw/psb56/tsd_products_support_series_home.html

Cisco Unified Presence Server
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

Cisco Unity Connection
http://www.cisco.com/en/U S/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products _support_series_home.html

Cisco Emergency Responder
http://www.cisco.com/en/US/products/sw/voicesw/ps842/tsd_products_support_series_home.html

Cisco Unity
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products support_series_home.html

Cisco Unified MeetingPlace
http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.html

Cisco Unified CallManager Express
http://www.cisco.com/en/U S/products/sw/voicesw/ps4625/tsd_products _support_series_home.html

Cisco Unity Express
http://www.cisco.com/en/U S/products/sw/voicesw/ps5520/tsd_products_support_series_home.html

Cisco Unity Connection
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html

Cisco Unified MeetingPlace Express
http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

Cisco Unified Survivable Remote Site Telephony (SRST)
http://www.cisco.com/en/U S/products/sw/voicesw/ps2169/tsd_products support_series_home.html

Cisco Unified Communications System for IP Telephony Release 5.0(2)
[ 76 | I


http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps842/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps4625/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps5520/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps2169/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

| Chapter7 Resource Library

Component Resources ||

Cisco Unified Videoconferencing Products
http://www.cisco.com/en/U S/products/hw/video/ps1870/tsd_products_support_series_home.html

Cisco 2600 Series Routers
http://www.cisco.com/en/US/products/hw/routers/ps259/tsd_products_support_series_home.html

Cisco 2800 Series Routers/Voice Gateways
http://www.cisco.com/en/U S/products/ps5854/tsd_products_support_series_home.html

Cisco 3700 Series Voice Gateways/Gatekeepers
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html

Cisco 7200 Series Voice Gateways
http://www.cisco.com/en/US/products/hw/routers/ps341/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Access Switches
http://www.cisco.com/en/US/products/hw/switches/ps646/tsd_products support_series_home.html

Cisco Catalyst 3560 Series Access Switches
http://www.cisco.com/en/US/products/hw/switches/psb528/tsd_products_support_series_home.html

Cisco Catalyst 3750 Series Data Center Switches
http://www.cisco.com/en/US/products/hw/switches/ps5023/tsd_products_support_series_home.html

Cisco Catalyst 6500 Series Switches
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products support_series_home.html

Cisco VG224/248 Analog Voice Gateways
http://www.cisco.com/en/US/products/hw/gatecont/ps2250/tsd_products_support_series_home.html

Cisco ATA 186/188 Analog Telephone Adaptors
http://www.cisco.com/en/US/products/hw/gatecont/ps514/tsd_products support_series_home.html

Cisco Security Agents
http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html

Cisco Fax Server
http://www.cisco.com/en/U S/products/ps6178/tsd_products_support_series_home.html

Cisco Secure PIX Firewall Servers
http://www.cisco.com/en/US/products/hw/vpndevc/ps2030/tsd_products_support_series_home.html

Cisco SIP Proxy Server
http://www.cisco.com/en/US/products/sw/voicesw/ps2157/tsd_products _support_series_home.html

Cisco Unified Operations Manager
http://www.cisco.com/en/US/products/ps6535/tsd_products_support_series_home.html
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CiscoWorks Resource Manager Essentials
http://www.cisco.com/en/US/products/sw/cscowork/ps2073/tsd_products_support_series_home.html

Cisco Unified IP Phones
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Cisco Unified VT Advantage
http://www.cisco.com/en/U S/products/sw/voicesw/ps5662/tsd_products support_series_home.html

Cisco IP Communicator
http://www.cisco.com/en/US/products/sw/voicesw/psb475/tsd_products support_series_home.html

Cisco Unified Personal Communicator
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html

Cisco Aironet 1200 Series Access Points
http://www.cisco.com/en/US/products/hw/wireless/ps430/tsd_products support_series_home.html

Cisco Unified Mobility Manager
http://www.cisco.com/en/US/products/ps6567/tsd_products_support_series_home.html

Cisco 10S Software Releases 12.4 T
http://www.cisco.com/en/US/products/ps6441/tsd_products_support_series_home.html

Configuration Command Files

You can download sample configuration files from this table for the components described in the
Additional Configuration Information topic in the Implement tab.

Table 7-2 Sample Component Configuration Files

Description Filename

Zip file includes Cisco device configurations listed |IPT_Tested_Configs.zip (right-click to
bel ow: download zip) includes the files below.

Note  Some parameters, such as passwords, have Note If you click the link rather than
been removed from the configuration files for right-click, the zip file may openinthe
security reasons. secondary window but also replace the
contents of this window. Use your
Back button to return to this window.

Cisco Unified CallManager Express on a Cisco CME_2611_Config.txt
2611 (ALT-CME-2611-4)
Cisco Unified CallManager Express on a Cisco CME_2651 Config.txt
2651 (YYZ-CME-2651-2)
Cisco Unified CallManager Express on a Cisco CME_2691_Config.txt
2691 (ALT-CME-2691-2)
Cisco Unified CallManager Express on a Cisco CME_3745 Config.txt

3745 (YYZ-CME-3745-1)

Cisco Unified Communications System for IP Telephony Release 5.0(2)
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Configuration Command Files

Sample Component Configuration Files (continued)

Description

Filename

Cisco Unified CallManager Express on a Cisco
3845 (ALT-CME-3845-3)

CME_3845_Config.txt

Cisco Unity Express on a Cisco 3745
(YYZ-CUE-3745)

CUE_3745_Config.txt

Cisco 3745 gatekeeper (SJC-RFD-GK-1)

Gatekeeper_3745 Config.txt

Gatekeeper configured as first gatekeeper in a
cluster

Gatekeeper_FirstinCluster_Config.txt

Gatekeeper configured as second gatekeeper in a
cluster

Gatekeeper_SecondinCluster_Config.txt

Cisco 3725 H.323 gateway
(SIC-RFD-3725GW1)

H323GW_3725 Config.txt

Cisco 3845 H.323 gateway (SJC-RFD-3845GW)

H323GW_3845_Config.txt

Cisco 3725 MGCP gateway
(SIC-RFD-3725-GW?2)

MGCPGW_3725_Config.txt

Cisco 2851 SIP gateway (DFW-2851-GW)

SIPGW_2851_Config.txt

Cisco 3745 SIP gateway (DFW-3745GW)

SIPGW_3745_Config.txt

Cisco Unified MeetingPlace Audio Server
MP-8112 (SJC-RFD-MP-1) license summary

MeetingPlace_License.txt

Cisco RSVP Agent configured for video
deployment

RSVPAgent_Video_ConfigExcerp.txt

QoS configured on a Cisco 3745
(SFO-ORD-104-3745)

QoS _3745_ConfigExcerp.txt

QoS configured on a Cisco Catalyst 4506
(SFO-ORD-4506)

QoS _4506_ConfigExcerp.txt

QoS configured on a Cisco Catalyst 7200
(SFO-ORD-WAN-1)

QoS _7200_ConfigExcerp.txt

Cisco Catalyst 6500 switch (CDG_CMM-GW_1)
configured for QSIG links

QSIG_Cat6500_Config.txt

Cisco 2801 configured as SIP MWI Client
(YYZ-CME-2801-6)

SIP_MWI_Client_2801.txt

Cisco 2851 configured as SIP MWI Relay
Server(YYZ-CME-2851-5)

SIP_MWI_Relay 2851.txt

Cisco Unified SRST for H.323 on a Cisco 2691
(HNL1-WAN-2691)

SRST_H323 HNL1 Config.txt

Cisco Unified SRST for MGCP on a Cisco 2691
(HNL2-SRST-2691)

SRST_MGCP_HNL2_Config.txt

Cisco Unified SRST for SIP on a Cisco 2821
(DFW-2-2821)

SRST_SIP_Remote2821 Config.txt

Cisco Unified SRST for SIP on a Cisco 3845
(DFW-REMOTE-3845)

SRST_SIP_Remote3845 Config.txtg

Cisco Aironet 1200 Access Point (AP)

Wireless AironetAP1200_Config.txt
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Table 7-2 Sample Component Configuration Files (continued)

Description Filename
Cisco Access Control Server for LEAP Wireless ACS _LEAP_Config.txt
Cisco Catalyst switch Firewall Service Module FWSM _Config.txt
(SIC-RFD-FWSM-1)
Cisco Secure PIX Firewall (DFW-PIX-1) PIX_Firewall_Config.txt
Cisco RSVP Agent on a Cisco 2821 RSVPAgent_2821 Config.txt
(DFW-2-2821)

System Test Results

This topic summarizes the results of Cisco Unified Communications Release 5.0(2) system testing for
I P telephony environments. This topic contains the following sections:

Testing Objectives
Tested Deployment and Site Models
Test Results

Testing Objectives

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring,
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of
system testing is to validate the seamless interoperability and stability of the components that make up
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the
system level and usability for system components

End-to-End Functionality Testing—To verify the end-to-end functionality of system components
Basic Functionality and Feature Testing—To verify basic call flows and component features

Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based
on TAC input

Interoperability Testing—To verify the interoperability among system components
Scalability Testing—To verify system functionality during scalability tests

Performance, Load, and Stress Testing—To verify system functionality during performance, load,
and stress tests

Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and
recovery, and behavior in redundant configurations

Cisco Unified Communications System for IP Telephony Release 5.0(2)
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Tested Deployment and Site Models

The System Test Architecture Reference Manual provides information about the components and
configurations that have been tested and verified as part of a given Cisco Unified Communications
release. For information about the components, configurations, and environment tested in Cisco Unified
Communications Release 5.0(2), see Tested Deployments and Site Models.

Test Results

The results of the system tests performed for 1P telephony during Cisco Unified Communications
Release 5.0(2) are shown in the System Test Results (right-click to download PDF).

The test results contain the following information:

» Title—Title of the test.

» |D—Identifier for the test.

» Description—Description of the purpose of the test.

» Features Tested—Component feature tested.

» Status—Result of the test and any defects related to the test case. Possible values are:
— Passed—Test case passed as described in the table.
— Failed—Test case failed and the reason is described in the listed defect.

— Passed with exception—Test case as described passed but an anomaly occurred that was not
directly related to the functionality being tested. Possible anomalies are as follows:

The test steps were modified based on the actual feature implementation.
The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as
required.

» Defects—Identifier for any defect that was opened against the test. If you have an account with
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:
— http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl (&

Cisco Sales Demo

The Cisco Sales Demo document is for Cisco sales teams and describes the various methods available
to demonstrate the Cisco Unified Communications System.

Cisco Unified Communications System Demonstration Programs &

Cisco Unified Communications System for IP Telephony Release 5.0(2)
| "=


http://wwwin.cisco.com/voice/programs/unified_demo/demo.shtml
http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc502/starmipt/uc05_mod.htm
http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl

http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc502/results/tript502.pdf

Chapter 7 Resource Library |
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